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BHARTIYA SHIKSHA BOARD  

Information Technology (SUBJECT  CODE- 054) 
Sample Question Paper for Class X (Session 2026-2027)   

Max. Time: 2 Hours                  Max. Marks: 50 
 

General Instructions: 

1. Please read the instructions carefully. 

2. This Question Paper consists of 21 questions in two sections: Section A & Section B. 

3. Section A has Objective type questions whereas Section B contains Subjective type 

questions. 

4. Out of the given (5 + 16 =) 21 questions, a candidate has to answer (5 + 10 =) 15 

questions  

    in the allotted (maximum) time of 2 hours. 

5. All questions of a particular section must be attempted in the correct order. 

6. SECTION A - OBJECTIVE TYPE QUESTIONS (24 MARKS): 

i. This section has 05 questions. 

ii. Marks allotted are mentioned against each question/part. 

iii. There is no negative marking. 

iv. Do as per the instructions given. 

7. SECTION B – SUBJECTIVE TYPE QUESTIONS (26 MARKS): 

i. This section has 16 questions. 

ii. A candidate has to do 10 questions. 

iii. Do as per the instructions given. 

iv. Marks allotted are mentioned against each question/part 

 

सामान्य निरे्दश : 

1. कृपया निरे्दशों को ध्यािपूर्वक पढ़िए।  

2. यह प्रश्ि-पत्र र्दो खंडों — Section A एर्ं Section B — में वर्भाजित 21 प्रश्िों से ममलकर बिा है।  

3. Section A में र्स्तुनिष्ठ प्रकार के प्रश्ि हैं, िबकक Section B में वर्षयपरक प्रकार के प्रश्ि हैं।  

4. ढर्दए गए (5 + 16 =) 21 प्रश्िों में से अभ्यर्थी को निर्ावररत (अधर्कतम) 2 घंटे के समय में (5 + 10 =) 

15 प्रश्िों के उत्तर रे्दिे हैं।  

5. प्रत्येक खंड के सभी प्रश्ि सही क्रम में हल ककए िािे चाढहए।  
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6. खंड क – वस्तुनिष्ठ प्रकार के प्रश्ि (24 अंक): 

(i) इस खंड में 05 प्रश्ि हैं। 

(ii) प्रत्येक प्रश्ि/भाग के सामिे निर्ावररत अंक ढर्दए गए हैं। 

(iii) ऋणात्मक अंकि (Negative Marking) िहीं है। 

(iv) ढर्दए गए निरे्दशों के अिुसार उत्तर र्दीजिए। 

7. खण्ड ख – ववषयपरक प्रकार के प्रश्ि (26 अंक): 

(i) इस खंड में 16 प्रश्ि हैं। 

(ii) अभ्यर्थी को 10 प्रश्ि करिे हैं। 

(iii) ढर्दए गए निरे्दशों के अिुसार उत्तर र्दीजिए। 

(iv) प्रत्येक प्रश्ि/भाग के सामिे निर्ावररत अंक ढर्दए गए हैं। 
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SECTION A: OBJECTIVE TYPE QUESTIONS 

खंड क : वस्तुनिष्ठ प्रकार के प्रश्ि 

Q. 1  Answer any 4 out of the given 6 questions on Employability Skills (1 x 4 = 4 marks) 

रोज़गार कौशल (Employability Skills) पर ढर्दए गए 6 प्रश्िों में से ककसी भी 4 प्रश्िों के उत्तर र्दीजिए। (1 × 4 = 4 

अंक) 

i. Identify the sentence that is in Passive Voice : 
(A) The students completed the project on time. 
(B) The project was completed by the students on time. 
(C) The students are completing the project. 
(D) The students will complete the project tomorrow. 
 

 उस र्ाक्य की पहचाि कीजिए िो Passive Voice में है : 
(A) वर्द्याधर्थवयों िे पररयोििा समय पर पूरी की। 
(B) पररयोििा वर्द्याधर्थवयों द्र्ारा समय पर पूरी की गई। 
(C) वर्द्यार्थी पररयोििा पूरी कर रहे हैं। 
(D) वर्द्यार्थी कल पररयोििा पूरी करेंगे। 

1 
 

ii. Regular exercise and balanced eating habits help a person remain ________. 
(A) Careless 
(B) Unhealthy 
(C) Fit 
(D) Weak 

 
नियममत व्यायाम और संतुमलत भोिि की आर्दतें व्यजक्त को ___________ बिाए 
रखिे में सहायता करती हैं। 
(A) लापरर्ाह 
(B) अस्र्स्र्थ 
(C) स्र्स्र्थ 
(D) कमिोर 

1 
 

iii. Define the term ‘Self-Motivation’. 
 

‘Self-Motivation’ शब्र्द को पररभावषत कीजिए। 

1 
 

iv. Which of the following is not a control key on the keyboard? 
(A) SHIFT 
(B) SPACEBAR 
(C) ALT 
(D) HOME  

 
निम्िमलखखत में से कौि-सी कंुिी (Key) कीबोडव की नियंत्रण कंुिी (Control Key) 
िहीं है? 
(A) मशफ्ट (SHIFT) 
(B) स्पेसबार(SPACEBAR) 
(C) ऑल्ट (ALT) 
(D) होम (HOME) 

1 
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v. A successful entrepreneur should be __________ and __________. 
(A) lazy, careless 
(B) confident, hardworking 
(C) fearful, weak 
(D) dishonest, impatient 

 
एक सफल उद्यमी को __________ और __________ होिा चाढहए। 
(A) आलसी, लापरर्ाह 
(B) आत्मवर्श्र्ासी, मेहिती 
(C) डरपोक, कमिोर 
(D) बेईमाि, अर्ीर 

1 
 

vi. Excessive cutting of trees leads to ____________. 
(A) increase in forests 
(B) soil erosion 
(C) clean air 
(D) water conservation 

 
पेडों की अत्यधर्क कटाई से ____________ होता है। 
(A) र्िों में र्दृ्धर् 
(B) सॉइल इरोिि 
(C) स्र्च्छ र्ाय ु
(D) र्ॉटर कंज़र्ेशि 

1 
 

 

 

 

 

 

 

Q. 2    Answer any 5 out of the given 6 questions                           (1 x 5 = 5 marks) 

ढर्दए गए 6 प्रश्िों में से ककसी भी 5 प्रश्िों के उत्तर र्दीजिए।                    (1 × 5 = 5 अंक) 

 

i.  Which style category is used to format the entire page? 
(A) Character Style 
(B) Page Style 
(C) List Style 
(D) Frame Style  
 

पूरे पषृ्ठ (Entire Page) को प्रारूवपत (Format) करिे के मलए ककस स्टाइल शे्रणी (Style 

Category) का उपयोग ककया िाता है? 

(A) कैरेक्टर स्टाइल (Character Style) 

(B) पिे स्टाइल (Page Style) 
(C) मलस्ट स्टाइल(List Style ) 

(D) फे्रम स्टाइल (Frame Style) 

1 
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ii.  Which toolbar contains options like Fill Color and Line Color? 
(A) Image Toolbar 
(B) Drawing Object Properties Toolbar 
(C) Standard Toolbar 
(D) Table Toolbar  
 

ककस टूलबार में Fill Color और Line Color जैस ेववकल्प उपलब्ध होते हैं? 

(A) इमेि टूलबार (Image Toolbar) 

(B) ड्रॉइंग ऑब्िेक्ट प्रॉपटीि टूलबार (Drawing Object Properties Toolbar) 

(C) स्टैंडडव टूलबार (Standard Toolbar) 

(D) टेबल टूलबार (Table Toolbar) 

1 
 

iii.  Which option protects the Table of Contents from manual editing? 
(A) Read Only 
(B) Protected against Manual Changes 
(C) Lock Editing 
(D) Restrict Access  
 

कौि-सा वर्कल्प Table of Contents को मैन्यअुल संपार्दि (Manual Editing) स े
सुरक्षित रखता है? 
(A) रीड ओिली (Read Only) 
(B) प्रोटेक्टेड अगेंस्ट मैन्युअल चेंिेि (Protected against Manual Changes) 
(C) लॉक एडडढटगं (Lock Editing) 
(D) ररजस्िक्ट एक्सेस (Restrict Access) 

1 
 

iv.  Which arrangement option places an image behind the text? 
(A) Bring to Front 
(B) Send to Back 
(C) To Foreground 
(D) To Background  
 

कौि-सा Arrangement वर्कल्प ककसी इमेि को टेक्स्ट के पीछे प्रर्दमशवत करता है? 
(A)  ब्रगं टू फं्रट (Bring to Front) 
(B)  सेंड टू बैक (Send to Back) 
(C)  टू फोरग्राउंड (To Foreground) 
(D)  टू बैकग्राउंड (To Background) 

1 
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v.  Drag and Drop method cannot be used to create which style? 
(A) Paragraph Style 
(B) Character Style 
(C) Frame Style 
(D) Page Style 
 

Drag and Drop ववधध का उपयोग ककस स्टाइल को बिािे के ललए िह  ंककया जा सकता? 
(A) पैराग्राफ स्टाइल (Paragraph Style) 

(B) कैरेक्टर स्टाइल (Character Style) 

(C) फे्रम स्टाइल (Frame Style) 

(D) पेि स्टाइल (Page Style) 

1 
 

vi.  LibreOffice Writer supports up to how many heading levels? 
(A) 5 
(B) 8 
(C) 10 
(D) 12 
LibreOffice Writer अधर्कतम ककतिे Heading Levels का समर्थवि करता है? 

(A) 5  
(B) 8  
(C) 10 
(D) 12 

1 
 

Q. 3  Answer any 5 out of the given 6 questions                            (1 x 5 = 5 marks) 

ढर्दए गए 6 प्रश्िों में से ककसी भी 5 प्रश्िों के उत्तर र्दीजिए।                      (1 × 5 = 5 अंक) 

 

i.  Which programming language is used for writing Macros in LibreOffice Calc? 
(A) Java 
(B) Python 
(C) BASIC 
(D) C++ 

LibreOffice Calc में Macros मलखिे के मलए ककस प्रोग्राममगं भाषा का उपयोग ककया िाता है? 

(A) िार्ा (Java) 

(B) पाइर्थि (Python) 

(C) बेमसक (BASIC) 

(D) सी प्लस प्लस (C++) 

1 
 

ii.  Which hyperlink stores the complete file location? 
(A) Relative Hyperlink 
(B) Absolute Hyperlink 
(C) Internal Hyperlink 
(D) Dynamic Hyperlink 
 

कौि-सा Hyperlink पूर  फाइल लोकेशि (Complete File Location) को सगं्रह त करता है? 

(A) ररलेढटर् हाइपरमलकं (Relative Hyperlink) 

(B) एब्सोल्यूट हाइपरमलकं (Absolute Hyperlink) 

(C) इंटरिल हाइपरमलकं (Internal Hyperlink) 

(D) डायिेममक हाइपरमलकं (Dynamic Hyperlink) 

1 
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iii.  Which option is used to insert tables from a webpage into Calc? 
(A) Link External Table 
(B) Import HTML 
(C) Link to External Data 
(D) Web Connect 

 

Calc में ककसी र्ेबपेि से टेबल insert करिे के मलए ककस वर्कल्प का उपयोग ककया 
िाता है? 

(A) मलकं एक्सटिवल टेबल (Link External Table) 
(B) इम्पोटव एचटीएमएल (Import HTML) 
(C) मलकं टू एक्सटिवल डेटा (Link to External Data) 
(D) र्ेब किेक्ट (Web Connect) 

1 
 

iv.  Which function can be used to find the highest marks? 
 

सबसे अधर्क अंक (Highest Marks) ज्ञात करिे के मलए ककस फंक्शि का उपयोग ककया 
िा सकता है? 

(A) SUM() 
(B) MAX() 
(C) COUNT() 
(D) AVG() 

1 
 

v.  Which option is used to share a spreadsheet with multiple users? 
(A) File > Share 
(B) Tools > Share Spreadsheet 
(C) Insert > Share Spreadsheet 
(D) Window > Share 
 

एक स्प्रेडशीट को अिेक उपयोगकतावओं (Multiple Users) के सार्थ साझा करिे के मलए 
ककस वर्कल्प का उपयोग ककया िाता है? 

(A) File > Share  
(B) Tools > Share Spreadsheet  
(C) Insert > Share Spreadsheet  
(D) Window > Share  

1 
 

vi.  Which function is used to combine information from multiple sheets into one 
place? 
(A) Sort 
(B) Filter 
(C) Consolidate 
(D) Merge 
 

अिेक शीट्स (Multiple Sheets) की िािकारी को एक स्र्थाि पर िोडिे के मलए ककस 
फंक्शि का उपयोग ककया िाता है? 

(A) सॉटव (Sort) 
(B) कफल्टर (Filter) 
(C) कंसोमलडेट (Consolidate) 
(D) मिव (Merge) 

1 
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Q. 4  Answer any 5 out of the given 6 questions                            (1 x 5 = 5 marks) 

ढर्दए गए 6 प्रश्िों में से ककसी भी 5 प्रश्िों के उत्तर र्दीजिए।                      (1 × 5 = 5 अंक) 

 

i.  Referential integrity ensures that __________ foreign key values do not exist 
in the database. 
(A) duplicate 
(B) unmatched 
(C) repeated 
(D) hidden  
 

Referential Integrity यह सुनिजश्चत करती है कक डेटाबेस में __________ Foreign 

Key values मौिूर्द ि हों। 
(A) duplicate (डुप्लीकेट) 
(B) unmatched (अिमैच्ड) 
(C) repeated (ररपीटेड) 
(D) hidden (ढहडि) 

1 
 

ii.  Which data model organizes data in a tree-like structure? 
(A) Relational Model 
(B) Network Model 
(C) Hierarchical Model 
(D) Object Model 
 

कौि-सा Data Model डेटा को र्िृ (Tree) िैसी संरचिा में व्यर्जस्र्थत करता  है? 

(A) ररलेशिल मॉडल (Relational Model) 
(B) िेटर्कव  मॉडल (Network Model) 
(C) हाइराककव कल मॉडल (Hierarchical Model) 
(D) ऑब्िेक्ट मॉडल (Object Model) 

1 
 

iii.  Which database object presents information in formatted manner? 
(A) Table 
(B) Query 
(C) Report 
(D) Form 
 

कौि-सा Database Object िािकारी को सुव्यर्जस्र्थत (Formatted) रूप में प्रस्तुत करता 
है? 

(A) टेबल (Table) 

(B) क्र्ेरी (Query) 

(C) ररपोटव (Report) 

(D) फॉमव (Form) 

1 
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iv.  A database designer notices that the same customer information is being 
entered repeatedly in multiple tables, increasing storage requirements and 
chances of errors. Which feature of DBMS helps reduce this problem?  
(A) Data Consistency 
(B) Minimal Data Redundancy 
(C) Data Security 
(D) Data Sorting 
 

एक Database Designer यह रे्दखता है कक एक ही ग्राहक (Customer) की िािकारी 
कई टेबल्स में बार-बार र्दिव की िा रही है, जिससे स्टोरेि की आर्श्यकता ब़ि रही है 
और तु्रढटयों (Errors) की संभार्िा भी ब़ि रही है। DBMS की कौि-सी वर्शेषता इस 
समस्या को कम करिे में सहायता करती है? 

(A) डेटा कंमसस्टेंसी (Data Consistency) 
(B) ममनिमल डेटा ररडडंेंसी (Minimal Data Redundancy) 
(C) डेटा मसक्योररटी (Data Security) 
(D) डेटा सॉढटिंग (Data Sorting) 

1 
 

v.  A school management system allows teachers to enter marks using a user-
friendly screen without directly accessing the actual database tables. Which 
database object provides this facility?  
(A) Query 
(B) Report 
(C) Form 
(D) Relationship 
 

एक School Management System मशिकों को र्ास्तवर्क database tables तक 
सीरे् पहुुँचे ब्बिा एक user-friendly स्क्रीि के माध्यम से अंक र्दिव करिे की सुवर्र्ा 
रे्दता है। यह सुवर्र्ा कौि-सा database object प्रर्दाि करता है? 

(A) क्र्ेरी (Query) 
(B) ररपोटव (Report) 

(C) फॉमव (Form) 
(D) ररलेशिमशप (Relationship) 

1 
 

vi.  Which query view is considered more flexible?  
(A) Wizard View  
(B) SQL View  
(C) Design View  
(D) Datasheet View 
 

कौि-सा Query View अधर्क लचीला (Flexible) मािा िाता है? 

(A) Wizard View (वर्ज़ाडव व्यू) 
(B) SQL View (एसक्यूएल व्यू) 
(C) Design View (डडज़ाइि व्यू) 
(D) Datasheet View (डटेाशीट व्यू) 
 

1 
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Q. 5  Answer any 5 out of the given 6 questions                            (1 x 5 = 5 
marks) 

ढर्दए गए 6 प्रश्िों में से ककसी भी 5 प्रश्िों के उत्तर र्दीजिए।                      (1 × 5 = 5 अंक) 

 

i.  The microbial indicators present in water are mainly used to: 
(A) improve colour of water 
(B) monitor ecosystem health 
(C) reduce oxygen level 
(D) increase water pressure 
 

पािी में उपजस्र्थत microbial indicators का मुख्य उपयोग ककसके मलए ककया 
िाता है? 

(A) पािी के रंग में सुर्ार करिा 
(B) इकोमसस्टम (ecosystem) के स्र्ास््य की निगरािी करिा 
(C) ऑक्सीिि स्तर को कम करिा 
(D) पािी के र्दबार् को ब़िािा 

1 
 

ii.  CPR stands for: 
(A) Cardio Pulmonary Resuscitation 
(B) Central Power Recovery 
(C) Controlled Pulse Reaction 
(D) Cardiac Prevention Routine 
 

CPR का पूर्ण रूप क्या है? 

(A) काडड वयो पल्मोिरी ररसमसटेशि (Cardio Pulmonary Resuscitation) 

(B) सेंिल पार्र ररकर्री (Central Power Recovery) 

(C) कंिोल्ड पल्स ररएक्शि(Controlled Pulse Reaction) 

(D) काडड वएक वप्रर्ेंशि रूटीि (Cardiac Prevention Routine) 

 

1 
 

iii.  During an evacuation, employees should generally avoid using: 
(A) emergency exits 
(B) staircases 
(C) elevators and escalators 
(D) assembly areas 
 

आपातकालीि निकासी (Evacuation) के र्दौराि कमवचाररयों को सामान्यतः ककसका 
उपयोग करिे से बचिा चाढहए? 

(A) इमरिेंसी एजजिट्स (emergency exits) 
(B) सीढ़ियाुँ (staircases) 
(C) एमलर्ेटसव और एस्केलेटसव (elevators and escalators) 

(D) असेंबली एररयाज़ (assembly areas) 

1 
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iv.  A sore lower back during computer work is generally caused due to: 
(A) excessive lighting 
(B) improper keyboard 
(C) lack of lumbar support 
(D) loud noise 
 

कंप्यूटर पर कायव करते समय कमर के निचले ढहस्से (Lower Back) में र्दर्दव 
सामान्यतः ककस कारण होता है? 

(A) अत्यधर्क प्रकाश (Excessive Lighting) 

(B) अिुधचत कीबोडव (Improper Keyboard) 

(C) कमर के निचले ढहस्से को उधचत सहारा ि ममलिा (Lack of Lumbar 

Support) 

(D) तेज़ शोर (Loud Noise) 

1 
 

v.  Materials like Magnesium and sodium belong to which fire classification: 
(A) Class A materials 
(B) Class B materials 
(C) Class C materials 
(D) Class D materials 
 

Magnesium और Sodium िैसे पर्दार्थव ककस Fire Classification में आते हैं? 
(A) क्लास A मैटेररयल्स (Class A materials) 
(B) क्लास B मैटेररयल्स (Class B materials) 
(C) क्लास C मैटेररयल्स (Class C materials) 
(D) क्लास D मैटेररयल्स (Class D materials) 

1 
 

vi.  Which of the following situations is most likely to create a physical 
hazard in an office environment? 
(A) Proper storage of equipment 
(B) Loose electrical wires on the floor 
(C) Adequate lighting 
(D) Comfortable seating arrangement 
 

निम्िमलखखत में से कौि-सी जस्र्थनत कायावलय (Office) के र्ातार्रण में शारीररक 
खतरा (Physical Hazard) उत्पन्ि करिे की सबसे अधर्क संभार्िा रखती है? 

(A) उपकरणों का उधचत भंडारण (Proper Storage of Equipment) 

(B) फशव पर ढीले वर्द्युत तार (Loose Electrical Wires on the Floor) 

(C) पयावप्त प्रकाश व्यर्स्र्था (Adequate Lighting) 

(D) आरामर्दायक बैठिे की व्यर्स्र्था (Comfortable Seating Arrangement) 

1 
 

 

 



054 – Information Technology – Class X    Page 12 of 17 

 
SECTON B: SUBJECTIVE TYPE QUESTIONS 

खण्ड ख :  ववषयपरक प्रकार के प्रश्ि 

 

 Answer any 3 out of the given 5 questions on Employability Skills (2 x 3 = 6 
marks) 
Answer each question in 20 – 30 words. 

रोज़गार कौशल (Employability Skills) पर ढर्दए गए 5 प्रश्िों में से ककसी भी 3 प्रश्िों के उत्तर 

र्दीजिए। (2 × 3 = 6 अंक) 

प्रत्येक प्रश्ि का उत्तर 20–30 शब्र्दों में र्दीजिए। 

 

Q. 6  Explain any two methods of communication.  
 

संचार (Communication) की ककसी भी र्दो वर्धर्यों का र्णवि कीजिए। 

2 
 

Q. 7  (a) Define self-awareness. 
(b) Mention any two characteristics of a self-aware person. 
 

(a) आत्म-िागरूकता (Self-Awareness) को पररभावषत कीजिए। 
(b) आत्म-िागरूक व्यजक्त की कोई र्दो वर्शेषताएुँ मलखखए। 

2 

Q. 8  Differentiate between Worm and Trojan Horse.  
 

Worm और Trojan Horse के बीच अंतर बताइए। 

2 

Q. 9  Explain any two functions of an entrepreneur. 
 

उद्यमी के ककसी दो कायों की व्याख्या कीजिए।   

2 

Q. 10  What are Sustainable Development Goals (SDGs)? Write any one example of 
an SDG. 
 

सतत वर्कास लक्ष्य (SDGs) क्या हैं? ककसी एक SDG का उर्दाहरण र्दीजिए। 

2 
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 Answer any 4 out of the given 6 questions in 20 – 30 words each (2 x 4 = 8 
marks) 

ढर्दए गए 6 प्रश्िों में से ककसी भी 4 प्रश्िों के उत्तर 20–30 शब्र्दों में र्दीजिए। (2 × 4 = 8 अंक) 

 

Q. 11  Differentiate between embedding and linking an image in LibreOffice Writer. 
 

LibreOffice Writer में इमेि को एम्बेड करिे और मलकं करिे के बीच अंतर बताइए। 
2 

Q. 12  Write any two rules for naming a Macro. 
 

मैक्रो (Macro) का िाम रखिे के कोई र्दो नियम मलखखए। 

2 

Q. 13  What is the advantage of linking sheets instead of copying data? 
 

डेटा की प्रनतमलवप (copy) बिािे के बिाय शीट्स को मलकं करिे का क्या लाभ है 

2 

Q. 14  Distinguish between a candidate key and an alternate key in a database 
table. 
 

डेटाबेस टेबल में कैं डडडेट की (Candidate Key) और अल्टरिेट की (Alternate Key) के बीच 

अंतर स्पष्ट कीजिए। 

2 

Q. 15  Mention any two precautions to reduce eye strain while working on 
computers. 
 

कंप्यूटर पर काम करते समय आुँखों पर तिार् (eye strain) कम करिे के मलए कोई र्दो 
सार्र्ानियाुँ बताइए। 

2 
 

Q. 16  State any two guidelines that an organisation should follow to maintain clean 
air in its surroundings. 
 

अपि ेआसपास के र्ातार्रण में स्र्च्छ र्ायु बिाए रखिे के मलए ककसी संगठि द्र्ारा अपिाई 

िािे र्ाली कोई र्दो ढर्दशानिरे्दश मलखखए।” 

2 
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 Answer any 3 out of the given 5 questions in 50– 80 words each (4 x 3 = 12 
marks) 

ढर्दए गए 5 प्रश्िों में स ेककसी भी 3 प्रश्िों के उत्तर 50–80 शब्र्दों में र्दीजिए। (4 × 3 = 12 अंक) 

 

Q. 17  Riya is preparing a long project report in LibreOffice Writer. Her report 

contains different sections like introduction, objectives, and conclusion. 

She formats headings using styles, inserts relevant images, and creates a 

table of contents for easy navigation. Her teacher also reviews the 

document and suggests corrections using the Track Changes feature so that 

Riya can see all modifications clearly. 

Answer the following questions: 

 

(a) Why are Styles important in formatting a long document like a project     

      report?  

 

(b) What is the purpose of inserting a Table of Contents in the document?  

 

(c) How does Track Changes help during editing of the document?  

 

(d) State one benefit of inserting images properly in a report.  

 

ररया LibreOffice Writer में एक लंबी प्रोिेक्ट ररपोटव तैयार कर रही है। उसकी ररपोटव 
में अलग-अलग सेक्शि हैं, िैसे पररचय, उद्रे्दश्य और निष्कषव। र्ह Styles का 
इस्तेमाल करके हेडडजंस को फॉमेट करती है, संबंधर्त तस्र्ीरें डालती है, और आसािी 
से िेवर्गेट करिे के मलए एक Table of Contents बिाती है। उसके मशिक भी 
डॉक्यूमेंट की समीिा करते हैं और Track Changes फीचर का इस्तेमाल करके सुर्ार 
सुझाते हैं, ताकक ररया सभी बर्दलार्ों को साफ-साफ रे्दख सके। 
निम्िमलखखत प्रश्िों के उत्तर र्दें: 
 

(a) प्रोिेक्ट ररपोटव िैसे लंबे डॉक्यूमेंट को फॉमेट करिे में Styles क्यों महत्र्पूणव हैं? 
 

(b) डॉक्यूमेंट में Table of Contents डालिे का क्या उद्रे्दश्य है? 

 

(c) डॉक्यूमेंट को एडडट करते समय Track Changes ककस तरह मर्दर्द करता है? 

 

(d) ररपोटव में तस्र्ीरों को सही तरीके से डालिे का एक फायर्दा बताएुँ। 

4 

Q. 18  A shopkeeper maintains monthly sales data of his products in LibreOffice 
Calc. He wants to find out how many units he must sell to achieve a target 
profit, and also analyse different profit scenarios by changing price and cost 
values. 
 
(a) Which tool in Calc helps the shopkeeper to find the required value to   
      achieve a target result? 
 
(b) How does the Goal Seek feature help in decision-making? 
 

4 
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(c) Mention one advantage of using What-if analysis in spreadsheets. 
 
(d) Why is it useful to test different values before finalising a business   
     decision? 
 

एक र्दकुािर्दार अपिे उत्पार्दों की मामसक ब्बक्री का डेटा LibreOffice Calc में रखता 
है। र्ह यह पता लगािा चाहता है कक एक निजश्चत मुिाफा कमािे के मलए उसे 
ककतिी यूनिट बेचिी होंगी, और सार्थ ही कीमत और लागत के माि बर्दलकर अलग-
अलग मुिाफे की जस्र्थनतयों का वर्श्लेषण भी करिा चाहता है। 
 

(a) Calc में कौि सा टूल र्दकुािर्दार को ककसी निजश्चत लक्ष्य को पािे के मलए ज़रूरी    

     माि (value) का पता लगािे में मर्दर्द करता है? 

 

(b) Goal Seek फीचर फैसले लेिे में ककस तरह मर्दर्द करता है? 

 

(c) स्प्रेडशीट में What-if analysis का इस्तेमाल करिे का कोई एक फायर्दा बताइए। 
 

(d) ककसी कारोबारी फैसले को अंनतम रूप रे्दिे से पहले अलग-अलग मािों को   
     िाुँचकर रे्दखिा क्यों फायरे्दमंर्द होता है? 

Q. 19  A school maintains a database in LibreOffice Base with two tables: 
STUDENTS and FEES. Each student has a unique Student_ID used in both 
tables. 
(a) What is the purpose of a primary key in a database table? 
 
(b)   Why is it important to use a common field like Student_ID in both  
        tables? 
 
(c) What is meant by relationship between tables in a database? 
 
(d)   Name the type of relationship that exists when one student can have   
       only one fee record. 

 
एक स्कूल LibreOffice Base में एक डेटाबेस रखता है जिसमें र्दो टेबल हैं: STUDENTS और 

FEES। हर छात्र की एक यूनिक Student_ID होती है, जिसका इस्तेमाल र्दोिों टेबल में ककया 
िाता है। 

(a) डेटाबेस टेबल में प्राइमरी की का क्या मकसर्द होता है? 

 

(b) र्दोिों टेबल में Student_ID िैस ेकॉमि फील्ड का इस्तेमाल करिा क्यों ज़रूरी है? 

 

(c) डेटाबेस में टेबल के बीच ररलेशिमशप का क्या मतलब होता है? 

 

(d) उस ररलेशिमशप के टाइप का िाम बताइए िो तब होता है िब ककसी एक छात्र का 
     मसफव  एक ही फीस ररकॉडव हो सकता है। 
 

4 
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Q. 20  Answer the following questions in the context of Fire Safety and  Emergency 
Preparedness : 
(a) Mention any two common causes of fire hazards at the workplace. 
 
(b) Why should emergency exits always remain unobstructed in an   
     organisation? 
 
(c) What is the purpose of a fire extinguisher in emergency situations? 
 
(d) Suggest any one precaution that employees should follow to prevent   
     electrical accidents. 
 

अजजि सुरिा (Fire Safety) और आपातकालीि तैयारी (Emergency Preparedness) 

के संर्दभव में निम्िमलखखत प्रश्िों के उत्तर र्दीजिए : 
(a) कायवस्र्थल पर आग लगिे के कोई र्दो सामान्य कारण बताइए। 
 

(b) ककसी संगठि में आपातकालीि निकास द्र्ार (Emergency Exits) हमशेा     
      अर्रोर्-मुक्त क्यों होिे चाढहए? 

 

(c) आपातकालीि पररजस्र्थनतयों में Fire Extinguisher का क्या उद्रे्दश्य होता है? 

 

(d) वर्द्युत र्दघुवटिाओं से बचिे के मलए कमवचाररयों द्र्ारा अपिाई िािे र्ाली कोई   
     एक सार्र्ािी बताइए। 

4 

Q. 21  A hospital maintains a database in LibreOffice Base to manage details of 
doctors and appointments. The database contains two tables — DOCTORS 
and APPOINTMENTS.  
The table DOCTORS has the fields : DoctorID (Primary Key), DoctorName, 
Specialization, Experience and ContactNo. 
 

The table APPOINTMENTS has the fields : AppointmentNo (Primary Key), 
DoctorID, PatientName, AppointmentDate and Fees. 
 
Based on the above, answer the following questions : 
 
(a) Name any two fields of the DOCTORS table where duplicate values    
      may be allowed. 
 
(b) Suppose the table DOCTORS already contains a record with DoctorID as   
     D101. Can another record with the same DoctorID be entered? Give    
     reason. 
 
(c) Is it possible to store scanned medical reports in a new field of the    
     APPOINTMENTS table? If yes, suggest a suitable data type for it. 
 
(d) Explain the concept of referential integrity with respect to the tables   
     DOCTORS and APPOINTMENTS. 
 

4 



054 – Information Technology – Class X    Page 17 of 17 

 

 

एक अस्पताल LibreOffice Base में डॉक्टरों और अपॉइंटमेंट्स का वर्र्रण प्रबंधर्त 
करिे के मलए एक डेटाबेस बिाए रखता है। इस डेटाबेस में र्दो तामलकाएुँ — DOCTORS 

और APPOINTMENTS — शाममल हैं। 
तामलका DOCTORS में निम्ि फील्ड हैं : 
DoctorID (Primary Key), DoctorName, Specialization, Experience और 
ContactNo. 
 

तामलका APPOINTMENTS में निम्ि फील्ड हैं : 
AppointmentNo (Primary Key), DoctorID, PatientName, AppointmentDate 

और Fees। 
 

उपरोक्त के आर्ार पर निम्िमलखखत प्रश्िों के उत्तर र्दीजिए : 
 

(a) DOCTORS तामलका के ऐसे कोई र्दो फील्ड बताइए जििमें समाि (duplicate)   

     माि हो सकते हैं। 
 

(b) माि लीजिए कक DOCTORS तामलका में DoctorID का माि D101 र्ाला ररकॉडव   
     पहले से मौिूर्द है। क्या उसी DoctorID के सार्थ र्दसूरा ररकॉडव र्दिव ककया िा    
     सकता है? कारण सढहत उत्तर र्दीजिए। 
 

(c) क्या APPOINTMENTS तामलका में स्कैि की गई मेडडकल ररपोट्वस को ककसी िए   
     फील्ड में संग्रहीत ककया िा सकता है? यढर्द हाुँ, तो उसके मलए उपयुक्त डेटा टाइप   
     सुझाइए। 
 

(d) DOCTORS और APPOINTMENTS तामलकाओं के संर्दभव में Referential   

      Integrity की अर्र्ारणा समझाइए। 


